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Introduction

Le premier objectif de ce document est de présenter en quelques pages les notions indispen-
sables pour une prise en main aisée du programme IGOR Pro (version 4) de la société WAVE-
MEeTRICSL. En second lieu, il constitue une introduction générale & Iacquisition de données par
ordinateur, déboucant sur une desciption sommaire des programmes d’acquisition développés
sous IGOR Pro que nous mettons a votre disposition. Pour leur utilisation, on se reportera a la
notice détaillée de chacun d’entre eux.

A — PRISE EN MAIN

Le logiciel IGOR Pro (fonctionnant aussi bien sous Windows que sous MacOS) se présente en
premier lieu comme un « grapheur » scientifique a interface graphique, parmi beaucoup d’autres.
Il permet ainsi de nombreuses représentations graphiques de toutes sortes de données, et leur
analyse par des outils de traitement numérique, comme les ajustements de courbes, des intégra-
tions ou dérivations numériques, lissage, convolution et déconvolution, transformation de Fourier
discrete, tests statistiques, etc...

Il s’en distingue toutefois par plusieurs caractéristiques essentielles :

— Il permet de manipuler des données en quantités tres importantes, limitées seulement
par la mémoire de la machine, et cela avec une rapidité inégalée. En particulier il peut
acquérir et traiter des images, et des jeux de données de plus grande dimensionnalité,
comme des enregistrements vidéo par exemple.

— En plus des méthodes « graphiques », il peut étre programmé a ’aide d’un langage de
script en ligne de commande, ce qui permet de réaliser tres simplement et tres rapidement
des « macrocommandes », pour le traitement de jeux de données successifs par exemple.

— Largement extensible par ’ajout de modules complémentaires, il permet 1’acquisition de
données, notamment a ’aide de 'interface GPIB disponible sur de nombreux appareils,
ou encore en pilotant des cartes d’entrées-sorties analogiques et digitales.

! Un «didacticiel » visant & présenter, en francais, les bases du logiciel, en se concentrant sur les choses
réellement utiles dans le contexte de la préparation a l’agrégation, constitue un part importante du TP « Outils
Informatiques » de la série 0.
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1 Objets et concepts fondamentaux

L’utilisation du logiciel conduit & manipuler des objets de différentes natures, que I’on peut
classer en domnées d’une part, et en objets d’interface graphique d’autre part. Les données
élémentaires manipulées par IGOR Pro peuvent étre des nombres (entiers, réels, ou complexes)
ou des chaines de caracteres. Toutefois, on utilise aussi des structures plus complexes, que
nous allons décrire.

1.1 Les « Waves »

Le type de donnée fondamental dans le logiciel est appelé wave (en abréviation de « waveform »),
et que ’on pourrait traduire en francais par « signal ». Pour IGOR Pro, un « signal » est une liste
de nombres (ou éventuellement de chaines de caracteres), qui peut étre manipulée comme un vec-
teur. A ce titre, on peut lui attribuer une unité, des volts par exemple, nécessairement la méme
pour tous les nombres de la liste. Notons qu'IGOR Pro gere automatiquement les (sous)multiples
k, M, G, T ou m, pu, n, p, f etc...

Les nombres de cette liste sont invariablement numérotés de 0 a N-1, ou N est le nombre
de points du «signal » considéré. En outre, chaque wave possede une échelle « horizontale »,
déduite des numéros de points par une transformation affine, correspondant a la valeur initiale
(i.e. du premier point) et a I’écart entre les points successifs de la liste. Cette échelle possede
elle-méme une dimension. Une wave semble ainsi constitué de deux vecteurs, X (’échelle) et YV’
(les données), a ceci pres que les points de X, calculés, sont nécessairement des réels, équidistants
et classés de facon monotone, alors que ceux de Y sont quelconques. Signalons d’ailleurs qu’ils
peuvent méme prendre les valeurs spéciales « NaN » (Not-a-Number), Inf, ou -Inf.

L’exemple typique est celui d’une courbe lue sur un oscilloscope numérique doté d’une inter-
face GPIB ou RS232 (cf. § B2l pour la définition de ces termes) : les valeurs Y (en volts) sont lues
I'une apres lautre et résultent d’autant de mesures, tandis que les valeurs en X (en secondes),
sont les instants d’échantillonnage, simplement déduits de la base de temps. On observera sur
la figure [l que la table fait bien apparaitre trois colonnes : les numéros de points, les abscisses
X (visiblement équidistantes), et les ordonnées Y.
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FiG. 1: Visualisation dans IGOR Pro d’une wave de 10 points,nommée « test », a gauche par
un graphique, a droite par une table.

Le logiciel IGOR Pro permet aussi de manipuler et d’afficher des waves multidimensionnelles
(de une & 4 dimensions), qui sont dotées d’autant d’échelles que de dimensions. En particulier, les



images numériques (« bitmaps ») sont commes des waves bidimensionnelles (en fait trois waves
bidimensionnelles pour une image en couleurs RVB ou une wave 3D, une seule wave 2Dpour des
niveaux de gris), et on pourra donc définir des échelles « spatiales » pour les deux directions du
plan X et Y. L’ensemble des outils de traitement des images pourra étre activé en sélectionnant
Analysis [> Packages [> Image Processing.

Il faut souligner que les « waves », identifiées chacune par son nom, existent dans
la mémoire de ’ordinateur de fagon totalement indépendante de leur représentation
sur un graphique ou dans une table, contrairement au données d’un tableur! Une
wave qui n’est pas utilisée ni affichée pourra étre supprimée (Data > Kill Waves) afin
de libérer de la mémoire.

1.2 Graphiques et tables

Il s’agit des outils d’interface graphique de base, et donc les plus utilisés. On trouve un
exemple de chacun des deux sur la figure [1l

Un graphique permet d’afficher un nombre illimité de waves, avec éventuellement un type
d’affichage (format) et un systeme d’axes différents pour chacune. On peut ouvrir autant de gra-
phiques que I'on souhaite, chacun dans une fenétre séparée, et ils peuvent sans restriction utiliser
les mémes waves. Ils sont liés de fagon dynamique aux waves : toute modification d’'une wave
entraine la mise a jour instantanée du ou des graphique(s). On dispose pour chaque graphique
de deux curseurs (A et B) qui peuvent étre soit «liés » & une wave, soit « libres ». Les fenétres
graphiques peuvent enfin étre dotées d’outils de controle, a des fins diverses de dépouillement
ou d’acquisition de données. De nombreux exemples seront données dans la section 2l

Les tables permettent quant a elles d’afficher sous forme numérique autant de waves que ’on
veut, dans ’ordre que 'on choisit, avec ou sans les valeurs de X. Elles sont un moyen commode
de saisir ou modifier des valeurs, d’ajouter ou supprimer des points, ainsi que de renommer des
waves ou encore de les supprimer ! A nouveau, les waves sont liées de fagon dynamique aux tables
qui les représentent.

1.3 La ligne de commande

Une particularité et une grande force d’IGOR Pro réside dans une petite fenétre, appelée
« fenétre de commande » située en bas de ’écran et nommée comme le fichier en cours. On y dis-
tingue deux zones : en bas la « ligne de commande », et au dessus 1’« historique des commandes ».
Chaque opération (ou presque) exécutée a l'aide des menus déroulants ou des diverses boites
de dialogue fait apparaitre la commande correspondante dans la ligne de commande, puis dans
I’historique une fois la commande achevée.

Les avantages de ce mode de fonctionnement sont les suivants :

— La présence de I'historique permet de garder une trace de toutes les opérations réalisées,
ce qui est tres précieux pour retrouver plus tard les modifications apportées au données
initiales ou les valeurs de différents parametres;

— en cas de commandes répétitives (ou erronées!), il est tres facile de rappeler la ligne
correspondante, de I’éditer éventuellement, et de I’exécuter sans repasser par les menus;

— certaines opérations rendant un grand nombre de données (comme un ajustement de
courbes par exemple) peuvent écrire leur résultats dans ’historique, ot ils sont disponibles
pour utilisation ultérieure ;



Igor : Prise en main

I'usage des menus permet d’apprendre progressivement les commandes, ce qui est précieux
pour accélérer certaines taches ou aborder la programmation ;

la ligne de commande permet de réaliser un grand nombre d’opérations qu’il serait plus
ou moins pénible de réaliser avec des boites de dialogue, ou avec une interface de type
tableur, en particulier 'arithmétique sur les waves.

Le dernier point de cette liste justifie & lui seul I'existence de la ligne de commande. Ainsi par
exemple, si sig0, sigl, et sig2 sont des signaux de type réel et de méme longueur, on pourra
exécuter :

1.
2.

Print 16#*pi qui écrira 50.2655 dans I'historique;

Variable d=sqrt(2) qui crée une variable nommée d et lui affecte la valeur numérique
de V2:

sig0=x, ou la variable prédéfinie x représente 1’abscisse de chaque point de sig0, compte
tenu de 1’échelle préalablement donnée a la wave sig0, ce qui revient a faire Y = X pour
chaque point ;

. 8ig1=Sin(sig0)/d qui écrira dans chaque point de sigl le sinus du point correspondant

de sig0, divisé par le nombre d;

. sig2=BessJ(2,x) qui tabulera dans sig2 la fonction de Bessel Ja2(x) (x défini par 1’échelle

de sig2);
sigl=sig2[2*p], ou la variable prédéfinie p représente le numéro de chaque point de sigi,
qui copie dans la premiere moitié de sigl une sur deux des valeurs de sig2;

Edit sig0, sig2.id as "matable" qui créera une nouvelle table, nommée "matable”, et
affichant les valeurs Y de sig0, ainsi que les valeurs X et Y de sig2.

D’une fagon plus générale, on écrira dans la ligne de commande soit une affectation (cas 2-6)
soit une opération, comme Edit, Print, etc (cas 1 et 7). Dans un cas comme dans l'autre, les
expressions utilisées peuvent impliquer des fonctions prédéfinies dans IGOR Pro, ou définies par
I'utilisateur. Dans tous les cas, les variables ou waves impliqués doivent soit exister, soit étre
explicitent créées par 'opération réalisée.

1.4

Les autres objets

On peut étre amené a utiliser d’autres types d’objets que les graphiques et tables évoqués
plus haut, que nous allons énumérer en indiquant sommairement leur utilité :

les motebooks sont de simples fichiers textes, qui peuvent servir & documenter les données

et leur traitement, et constituer une sorte de « cahier de manip » électronique;

les control panels, qui sont des fenétres purement dédiées a 'interface utilisateur, en général

avec un programme qui y lit et/ou écrit différents parametres;

les page layouts qui, comme leur nom l'indique, permettent de mettre en page un certain

nombre de graphiques et de tables, éventuellement assortis de commentaires, en vue de

I’impression ;

les fenétres d’aide, qui sont tres proches des notebooks, si ce n’est qu’on ne peut les modifier

(;-)), et qu'ils ont généralement une structure hypertexte ;

la fenétre de procédures nommée Procedure, généralement cachée, qui contient :

— les fonctions de « fit » définies par 'utilisateur,

— les procédures de ré-création des graphiques, tables, panels et layouts que IGOR Pro
propose de créer automatiquement lorsqu’on détruit 'un de ces objets,



— toute macro écrite par 'utilisateur, en s’inspirant de I’historique...
— les fenétres de procédure, qui contiennent des fonctions définies par 1’éditeur ou par 1'uti-
lisateur, dont en particulier celles nécessaires a 1’acquisition de données.

1.5 Les fichiers

Pour finir, il faut bien parler des fichier utilisés par IGOR Pro. L’ensemble des données, et
les différents objets graphiques, tables, panels, notebooks, procédures, etc, d’'une méme session
constituent pour IGOR Pro une «expérience » (experiment). Cet ensemble peut étre stocké
comme un tout dans un unique fichier .pxp, ou dans un répertoire ou chaque wave et chaque
objet sont dans un fichier séparé (format .uxp).

Pour des raisons évidentes d’organisation, il faut absolument utiliser le format
compacté .pxp. Notons que 'on peut toujours, si nécessaire, exporter des données ou des gra-
phiques avec les commandes idoines. Vous pouvez aussi étre amenés a utiliser des fichiers modeles
(templates) d’extension .pxt, qui contiennent déja un certain nombre d’objets, de procédures,
voire de données. Bien sir, vous ne devrez en aucun cas enregistrer votre travail dans ce format !

Pour I'acquisition et le traitement des données, on sera amené a utiliser (de fagon aussi trans-
parente que possible!) des fichiers de procédure, d’extension .ipf, qui sont chargés par IGOR Pro
en fonction des besoins, et qui nécessitent d’étre compilés (menu Macro > Compile) pour que
les fonctions qu’ils définissent soient disponibles.

1.6 Programmation pour IGOR Pro

Il n’est bien sur pas question, dans le contexte de la préparation a ’agrégation, d’apprendre
a programmer pour IGOR Pro. Néanmoins, il est indispensable d’avoir en téte quelques idées
générales sur le sujet pour ne pas perdre (trop) de temps si quelque chose ne « marche pas »...
Les « fonctions » (au sens général du terme) prédéfinies dans IGOR Pro sont de deux types :
— les fonctions proprement dites, qui s’écrivent avec des parentheses, et prennent un nombre
défini (mais éventuellement nul) d’arguments, et retournent un nombre ou une chaine de
caracteres (mais en aucun cas une wave)
— les opérations, qui s’écrivent sans parentheses, prennent un nombre variable d’arguments,
et réalisent une action donnée sur leurs arguments, mais ne retournent pas de valeur.
Pour étendre les fonctionnalités d’IGOR Pro, c’est a dire lui faire exécuter des taches ou des
calculs qui ne sont pas assuré(e)s par les fonctions et opérations prédéfinies, il devient nécessaire
de programmer. Cela prend deux formes nettement distinctes :
— On écrit en C++ ou en Fortran une DLL selon certaines régles pour qu’elle puisse s’inter-
facer avec IGOR Pro, et on crée ainsi une « extension » appelée « eXternal OPeration », ou
XOP en abrégé. A condition d’étre chargée par IGOR Pro au démarrage, cette extension,
contenue dans un fichier binaire de type .xop, fournit de nouvelles opérations et fonctions.
— On reste dans IGOR Pro, et on écrit des « procédures » a ’aide des fonctions ou opérations
fournies par IGOR Pro et ses extensions, dans un langage de script propre au logiciel, mais
qui ressemble & la fois au C et au basic.
C’est la seconde méthode, plus légere, que nous avons employée pour développer les pro-
grammes d’acquisition de données que nous mettons a votre disposition. Ces programmes re-
posent fortement sur Putilisation de XOP dédiées & linterfacage avec les appareils de mesuré?.

2Ces XOP sont nommément : GetInputState.xop, VDT.xop, NIGPIB.xop, NIDAQ.xop, SoundInput.xop,
VFWGrabber . xop
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Les « procédures » écrites dans IGOR Pro sont elles-mémes de divers types :

— Les macros et les procédures sont une successions de commandes telles qu’entrées sur

la ligne de commande, avec des possibilités réduites de tests et de boucles. Les macros ne
different des procédures que par leur déclaration, et apparaissent dans le menu Macros.
Les macros et procédures ne sont pas compilées mais seulement interprétées lors de leur
exécution.

Les procédures de définition de graphiques, tables, panneaus, mises en pages, etc... sont
des macros particulieres, dont la déclaration définit le type d’objet créé; elles apparaissent
dans les menus Windows > Graph Macros ou Windows > Table Macros, etc...

Les fonctions, déclarées comme Function Nom_de_fonction, sont des procédures de
structure plus élaborées, pouvant utiliser des variables locales, et qui sont réellement com-
pilées. Elles renvoient éventuellement une valeur de type nombre ou chaine de caractere.
Comme les procédures, elles ne figurent a priori dans aucun menu, mais peuvent étre ap-
pelées depuis la ligne de commande. Nous avons préféré ce type chaque fois que cela était
possible.

2 Un exemple simple

Lorsqu’on lance Igor, on voit défiler dans la ligne d’état (en bas de I’écran) les noms des XOP
qu’il charge au démarrage). On obtient une table vide, que ’on peut fermer pour l'instant, et la
fenétre de commande nommée Untitled. Si I’on fait File > Save Experiment As on peut enregistrer
I'expérience avec un nom convenable (disons test), en prenant garde a enregistrer dans le
dossier Mes Documents et non dans le dossier Igor Pro Folder! La fenétre de commande
est alors nommeée test.

Manipulation et visualisation de données a I’aide des menus

1.
2.

Sélectionner Data > Make Waves et remplir la boite de dialogue comme Fig Pta

Sélectionner Data > Change Waves Scaling et remplir la boite de dialogue comme Fig 2tb,
de fagon a ce que X varie de 0 a 2 (prendre garde & bien sélectionner le mode Start and
End);

Saisir dans la ligne de commande : ytest=exp (-2+*x)*sin(30%*x) et valider;

Sélectionner Windows > New Graph et valider en prenant soin de choisir _calculated_
pour les valeurs de X (cf comme Fig[2lc);

. Sélectionner Data > Duplicate Waves, s’assurer que le modele est bien ytest, et saisir le

nom xtest puis valider;

Pointer dans I’historique la ligne ytest=. .. et valider; la formule apparait dans la ligne
de commande : I’éditer pour obtenir xtest=exp (-2#*x)*cos(30%*x) et valider;

Sélectionner Graph > Append Traces... et dans la boite de dialogue, sélectionner xtest
pour Y et _calculated_ pour X en conservant les axes par défaut ;

Double-cliquer dans le graphique pour obtenir la boite de format des courbes : la remplir
comme Fig[2kd;

les courbes obtenues peuvent étre vues comme la position et la vitesse d’un oscillateur
amorti; pour obtenir un portrait de phase, il suffit de tracer ytest en fonction de xtest :
sélectionner Windows > New Graph, et choisir les waves Y et X en conséquence;
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10. pour obtenir des axes plus appropriés, double-cliquer sur I'un des axes, pointer ’onglet
Axis range et sélectionner les options Round. .. et Symetric... comme sur la Fig 2re;
répéter la méme procédure pour l'autre axe.

L’écran d’IGOR Pro doit alors avoir une apparence proche de la figure

Enregistrer ’expérience. Fermer IGOR Pro, puis le réouvrir. Sélectionner File > Recent
Experiments, et choisir le fichier en question. Vérifier que tous les éléments, graphiques, waves,
et autres se retrouvent dans 1’état initial.
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B — ACQUISITION DE DONNEES

3 Généralités sur ’acquisition de données

L’acquisition de données par ordinateur, permet de rendre certaines mesures plus rapides,
plus systématiques, et plus aisément exploitables. En plus des capteurs et appareils de mesure
usuels, elle nécessite plusieurs ingrédients essentield :

1. un convertisseur analogique-numérique ;
2. une interface, c’est a dire un moyen de communication entre les appareils et 'ordinateur ;

3. un logiciel pour controler les uns et les autres et enregistrer les données ; parfois, le logiciel
« pilote » en outre un parametre de I’expérience.

3.1 Les convertisseurs

Les convertisseurs analogiques-numériques (et numériques analogiques) figurent au programme
de Dagrégation, et sont donc hors de notre propos. Il suffit de savoir que 'on dispose — entre
autres — des matériels suivants :

— des multimetres numériques (spécialement HP34401A) et de GBF numériques (spéciale-

ment HP33120A) ;

— des oscilloscopes numériques (spécialement TDS1012/3014 et HP54600) ;

— des cartes multifonctions (AD, DA, compteurs, etc...) directement intégrées dans 1’ordina-

teur (spécialement NIDAQ PCI-6014) ;

— des caméras vidéo numériques au format « Webcam ».

3.2 L’interfacage

Il existe de nombreux moyens de communications disponibles entre I'ordinateur et ses « péri-
phériques », dont les appareils de mesure font partie. Chacun de ces moyens repose sur une
architecture matérielle bien précise, généralement appelée « bus », et a une méthode bien précise
d’échange, appelée « protocole », qui est une sorte de langage minimal commun entre les deux
« interlocuteurs ».

Le terme de « bus » désigne de fagon plus précise un ensemble de de lignes conductrices dont
certaines sont destinées a coder les données binaires, et d’autres a indiquer quels sont I’émetteur
et le destinataire des données (de fagon générique les « adresses » de ceux-ci), ainsi que des signaux
de dialogue, donnant des informations du type « données prétes », « données lues », « envoyez la
suite », « fin de communication », etc..., communément appelées « handshaking ». Sur un bus, les
différents périphériques sont en général connectés en paralléle, mais ce n’est pas toujours le cas,
et certains ne permettent de communiquer qu’avec un nombre restreint de périphériques (de 1
a 16).

La liste de tous les bus et interfaces utilisés dans un ordinateur évolue en permanence ; voici
la liste, délibérément simplifiée, de ceux qui peuvent srvir a l'interfacage, en commencant par
les bus paralleles :

- les bus IDE/ATA (pour Integrated Drive Electronics / AT-Attached) et SCSI (pour Small
Computer Systems Interface) servant pour la communication avec des périphériques de stockage ;
- le bus d’extension PCI (pour Peripheral Component Interconnect) permettant la connexion de

3La liste qui suit doit étre comprise de facon générique, et chacun de ses éléments pourrait donc étre au pluriel.
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nombreuses « cartes filles », qui compléte ou remplace le vieux bus ISA (pour Industry Standard
Architecture) ;

- le bus GPIB (pour General Purpose Interface Bus), ou IEEE488, qui est spécialement utilisé
dans le domaine de 'instrumentation numérique ;

- le LPT (pour Local Printer Terminal) ou port parallele, ou encore IEEE 1284, utilisé par les
imprimantes ou d’autres périphériques;

et pour les bus série :

- les ports série COMx, ou RS232 (pour Recommended Standard 232) ;

- le bus USB (pour Universal Serial Bus) ;

- le bus « FireWire® » ou «iLink® » ou IEEE 1394, bus série rapide, principalement utilisé par
les périphériques de vidéo numérique haute résolution

Oscillo, GBF,
Multimétre, etc

)
)

ss|(se S "
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| £3||§%|| 8 Adapt.
/—*ﬂ SEJ AR = USB-GPIB '
{ Spectro __k_e—_/_ﬁ—g:ﬁ_ ey
|| fibré oy o Y v g3 !
= - Qo A~
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I o5 ||2® S o =g ||
MBue £% || 55 UsB Sa|| ga |l
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: Bus PCI |
A
| ¥ I
I CPU I
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F1G. 4: Schéma fonctionnel des différentes interfaces, et des appareils (en grisé) qui s’y
connectent ; le rectangle pointillé délimite le boitier de I'ordinateur.

Dans les ordinateurs de type PC actuels, le lien fondamental entre 'ordinateur et les péri-
phériques externes est le bus PCIL. Certains appareils, et notamment les cartes AD-DA comme
la carte NIDAQ PCI-6014, y sont directement connectes, dans I'un des « slots » disponibles sur
la carte-mere. Les autres appareils utilisent des liaisons qui sont « cascadés » au moyen d’adap-
tateurs intermédiaires comme schématisé sur la figure @l C’est le cas en particulier de l'interface
« GPIB », qui est la plus commune sur les appareils pouvant fonctionner de facon autonome.
Néanmoins, cela est totalement transparent pour I'utilisateur, qui doit simplement sélectionner
le bon connecteur sur le boitier de ’ordinateur.

Fi1G. 5: En haut, a gauche : port RS232, a droite : Port paralléle. En bas, a gauche : port et
prise USB, a droite : port GPIB.

Concretement, en plus des cartes déja connectées sur le bus PCI, on utilisera pour 1’acquisi-
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tion de données les interfaces suivantes, dont les connecteurs sont représentés a la figure [ :
— la liaison «série » (ou RS 232), avec les ports (mono-instrument) COM1 et COM2;
— la liaison « parallele », (ou IEEE 1284), avec le port LPT ou Imprimante;
— la liaison USB, (liaison série multi-périphérique) ;
— enfin, et surtout, la liaison « GPIB ».

3.3 Le logiciel

Un certain nombre des appareils dotés d’une interface numérique et permettant ’acquisition
de données informatisée utilisent un logiciel spécifique. Nous renvoyons en annexe une table
donnant tres succinctement la désignation de ces appareils, de U'interface utilisée, du logiciel
correspondant, et de l'usage de ceux-ci. Pour le mode d’emploi, on se reportera aux notices
correspondantes.

On donne ci-dessous une description sommaire des programmes d’acquisition de données
que nous avons développés en utilisant les grandes possibilités d’IGOR Pro dans ce domaine.
Ces programmes, congus de fagon a étre relativement « génériques », se prétent a de nombreux
types d’acquisition de données et de traitement dans un seul et méme environnement. Tous
ces programmes sont accessibles via le menu dynamique Acquisition que nous avons ajouté a
IGOR Pro (cf. figure [@). Pour leur utilisation, on se reportera aux notices correspondantes.

=1ofx]

File Edit Data Analysis Macros ‘Windows Misc Help | Acquisition
Dsciloscope
Appareils... Diagramme de Bode
Traitement. .. Enregistrewur

Appareils GPIE 7 Capture d'images
Reset DataFolder

=T

F1a. 6: Menu Acquisition

Le chargement d’un programme utilisant un ou plusieurs appareils peut toujours étre fait, que
le matériel soit présent ou non. Par contre, avant de commencer a communiquer avec un appareil,
il est nécessaire d’initialiser la communication, en utilisant une procédure qui est disponible dans
le sous-menu correspondant de Acquisition et/ou par un bouton « » accessible sur la fenétre
de controle de I’expérience.

Dans le cas — le plus fréquent — de la connexion GPIB, une fenétre s’ouvre demandant de
confirmer les adresses de la carte (conserver "gpib0"), et de I’appareil, sous la forme "devX",
ot X est un nombre de 1 & 15, appelé « adresse GPIB » de l'appareif. La valeur par défaut
proposée correspond en général a ’adresse utilisée a Montrouge. Lorsque l'initialisation se passe
bien, I'identité de ’appareil apparait dans la fenétre de commande. En cas d’échec, une fenétre
apparalt, invitant a vérifier I’adresse sur I’appareil, et sa bonne connexion. La commande Lister

4Cette adresse est fixée au niveau de I'appareil, & 1’aide d’un menu approprié.
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Appareils GPIB du menu Acquisition permet aussi d’obtenir une liste des appareils connectés sur
I'interface GPIB, avec leur adresséd.

Les programmes disponibles dans IGOR Pro sont les suivants :

1. « Oscilloscope » qui permet de relire, et d’exploiter dans IGOR Pro, les traces chl/2 et
Math d’un oscilloscope numérique;

2. « Bode» qui permet l'acquisition automatisée de la fonction de transfert de différents
systemes linéaires, en électronique en particulier, et le tracé et 'analyse des diagrammes
de Bode correspondants ;

3. « Enregistreur », qui permet d’enregistrer sous forme numérique 1’évolution (temporelle
ou asynchrone) de différents signaux sur des appareils trés divers : il s’agit en quelque sorte
d’une super-« table tracante numérique » ;

4. «sYnchroniX », qui s’apparente a l’enregistreur, mais fonctionne beaucoup plus rapide-
ment (jusqu’a 200 000 points par seconde), et/ou plus longtemps, grace a 'usage de la
carte PCI National Instruments (NIDAQ) ;

5. « Capture d’image » qui permet d’enregistrer des images fixes, a ’aide de la Webcam,
puis de les traiter.

6. « Dynamique » qui permet d’importer des vidéos enregistrées grace a la Webcam, et
d’analyser le mouvement des mobiles enregistrés.

Remarques importantes

1 Nous avons choisi de ne pas régler les appareils par logiciel : avec ou sans ordinateur, il
incombe aux utilisateurs de choisir les calibres, modes de déclenchement, et autres parametres
pertinents.

2 Tous les contrdles (ou presque) utilisés pour cl’acquisition possedent une aide succincte qui
apparait dans la barre d’état (bas de la fenétre) lorsque le pointeur de la souris les « survole ».
3 Les fenétres principales sont des interfaces pour 'acquisition, et ne doivent pas servir au trai-
tement, sous risque de compromettre les séquences d’acquisition ultérieures. Les waves qu’elles
affichent sont le plus souvent inaccessibles a l'utilisateur, et un bouton permet d’en créer des
copies pour traitement, dans des fenétres appropriées.

Comment ¢a marche ?
IGOR Pro utilise pour étendre ses possibilités un type particulier de librairies appelées XOP (pour eXternal

OPerations), ou extensions. Un certain nombre d’entre elles fournissent des interfaces vers les matériels d’acqui-
sition de données, et nous avons plus particulierement utilisé les suivantes :
— NIGPIB.xop permet la communication GPIB avec tous les appareils possédant cette interface, pourvu que
P'on utilise un adaptateur de la marque National Instruments;
— NIDAQ.xop permet de piloter les cartes d’acquisition du méme fournisseur ;
— VDT.xop gere la communication série;
— VFWGrabber.xop et GetClipboardImage.xop permettent la capture d’image;

Dans un systéme convenablement configuré, ces extensions sont automatiquement chargées par IGOR Pro lors de

son démarrage.

5Si I’échec persiste, il peut étre nécessaire de fermer IGOR Pro (en enregistrant les données si I’on souhaite),
puis de ré-ouvrir le programme.
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A Appareils fonctionnant avec un logiciel spécifique
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Appareil Logiciel Usage Interface g
Spectroscope Avasoft 5 Analyse spectrale de la lumiere (visible) | ISA/USB | 1/1
Barrette CCD Caliens Caliens* Enregistrement de figures de diffraction LPT 1
Carte AD-DA Sysam | Synchronie 2003 ** Digitalisation de signaux électriques PCI 1
Carte AD-DA NIDAQ IGOR Pro voir notice spécifique PCI 3
Webcam Philips AmCAP*** Capture d’images fixes ou de vidéo USB 2
Cameéra Leybold Vidéocom™**** Analyse du mouvement d’un objet COM 1

Paires matériel/logiciel pour 'acquisition de données informatisée.
« : peut aussi étre exploitée dans IGOR Pro, en lisant le signal vidéo sur un oscillo numérique;
«+ : des fonctions trés similaires sont disponibles dans le programme IGOR Pro « sYnchroniX » ;
wxx : peut aussi étre exploitée dans IGOR Pro : voir notice « Capture d’image » ;
wxxx ;| peut généralement étre remplacée par la webcam, avec analyse du film dans IGOR Pro.
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